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Changes in V2:

Customer version
Updated the attributes required to record a wav file.
Added Section 5-Troubleshooting a Fax Send Failure.
Added Section 6-Troubleshooting a Fax Receive Failure.
Added Section 7-Fax Error Codes.
Updated description in Section’s 1.3 and 4 regarding SE settings that can be
changed.
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1 Fax Electronic Checklist
In the X64x, X85x and X4600 series of MFDs, the fax checklist will be available on the
product’s SE webpage (http://ipaddress/se).
NOTE: If a fax failure occurs between two Lexmark machines, a fax checklist for each
machine must be completed.

http://ipaddress/se)
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1. Fill out the following information: Name of tester, Customer failed fax Job ID,

How to Gather Job ID information

Find the Job ID on:

 The printed Transmission/Receive log.

 T30 log (http://ipaddress/se “Dump Fax T30 Log” or “Dump Last 10 of Fax
T30 Logs”),

 Fax Call log (http://ipaddress Reports “Fax Call Log”), or Fax Job log
(http://ipaddress > Reports > “Fax Job Log”).

http://ipaddress/se
http://ipaddress
http://ipaddress
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2. Fill out the date and time of the fax failure.

3. Select the type of connection the machine is using.

4. Check the description of the type of connection the machine is using.

5. Make the choice that fits the line condition. To find out if there is noise over the line,
call the fax number and listen for noise. A clear line should be free of hums and static.
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1.2 Fax Checklist Part II

6. Choose the type of fax problem. When collecting debug from the sender, select
“Send”. When collecting debug from the receiver, select “Receive”.

7. Describe the sending machine. If “Lexmark MFD” is selected, the “Make” and
“Model” fields will not be accessible since the report will automatically extract
this information from the device. If the device is not a Lexmark device, the
“Make” and “Model” fields must be manually entered.

8. Describe the receiving machine. If “Lexmark MFD” is selected, the “Make” and
“Model” fields will not be accessible since the report will automatically extract
this information from the device. If the device is not a Lexmark device, the
“Make” and “Model” fields must be manually entered.
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9. Enter the code levels for each application. If the “Type of Problem” is “Send”,
these fields will be automatically supplied. If not, the code levels can be access
from the Fax SE Menu from the op panel (**411) and webpage (http://ipaddress
> Reports > “Device Information”).

10. Enter the code levels for each application. If the “Type of Problem” is “Receive”,
these fields will be automatically supplied. If not, the code levels can be access
from the Fax SE Menu from the op panel (**411) and webpage (http://ipaddress
> Reports > “Device Information”).

11. The technical support representative may request a wav recording of the fax
failure. If so, check this field if you are supplying a wav recording from the
sending side. (see section 2)

12. The technical support representative may request a wav recording of the fax
failure. If so, check this field if you are supplying a wav recording from the
receiving side.

13. Describe any visible error messages on the sending side.

14. Describe any visible error messages on the receiving side.

http://ipaddress
http://ipaddress
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1.3 Fax Checklist Part III

15. Check whether it is a consistent or intermittent problem. Describe the problem.
16-19. Describe the troubleshooting that has been done and select the proper
responses to each question. It is important to supply as much information as possible
in these boxes. Please refer to Sections 5-7 for troubleshooting information.
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20. Submit will automatically collect the necessary debug from the machine and
save the checklist by prompting you to save a file named “faxsngevent” to your
PC. When escalating the issue, you must supply this file to the technical support
center. Reset will clear all the fields from the checklist. Cancel will bring you
back to the main SE Menu webpage.

1.4 Additional In formation
It is important to note that pressing “Submit” does not send the debug and checklist
automatically to any Lexmark tech support server or email. It simply gathers the
necessary debug and saves the checklist to a file name “faxsngevent”. You must still
manually send this file to the technical support center TSC when escalating a fax
issue.
The faxsngevent fill contains the following information:

Fax Checklist
Last 10 fax T30 logs
Caller ID log (if available)
Fax settings page
Fax call log
Fax job log
Network settings page
History log
Lbtrace
Printer settings
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2 Recording .wav File (Possible Engineering Request)

If members of the engineering staff are unable to determine the cause for the fax
failure, it may be requested that that a recording of the facsimile be submitted for
evaluation.

Connect the Omnicron LIC-100 isolation coupler to a logging recorder (PC) and the
telephone circuit as shown in the connection diagram below.

Connection Diagram

Use a .wav file recording program to record the entire failing fax call. Examples of
.wav recording programs are:

� Audacity – available at http://audacity.sourceforge.net/
� CD Wave – available at http://www.cdwave.com/
� Windows Sound Recorder
� Scanner Recorder – available at http://www.davee.com/scanrec/

http://audacity.sourceforge.net/
http://www.cdwave.com/
http://www.davee.com/scanrec/
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Steps to record a wav file using Window’s Sound Recorder.

1. Open Windows Sound Recorder. (Windows 95: Start ĺProgramsĺMultimedia
SoundĺRecorder. Windows 98, 2000, & XP: Start ĺProgramsĺEntertainment ĺ
Sound Recorder)

2. Go to File > Properties > Convert Now and select these options:
a. Format: PCM
b. Attributes: 22,050 Hz, 8 Bit, Mono

3. Select Save As, and then name the file Fax Record . Click OK twice.
4. Press the Record button and let the Recorder run for 60 seconds.
5. After the Recorder has stopped go to the File Menu and choose save as. Name

the file BLANK.WAV and save it.
6. To increase the recording time from the default maximum of 60 seconds,

follow this process:
a. Select the Edit menu.
b. Choose Insert File and select the BLANK.WAV created in step 5.
c. This process increases the maximum recording time of Sound Recorder by

60 seconds. Repeat step 6 to add one minute of record time. For example,
for a 5 minute recording time, insert BLANK. WAV five times using step
6.

7. Once you have enough record time allocated, start the Recorder and capture the
failing fax call.

Steps to record a wav file using Audacity’s sound recording program.

1. Run the Audacity program.
2. Go to Edit > Preferences .
3. A window titled 'Audio Preferences’ will open up.

a. Under the "Audio I/O" tab, make sure that 'Channels'= '1(Mono)'.
b. Under the "Quality" tab, make sure that 'Default Sample Rate' = '22050

Hz'.
c. Under the "File Formats" tab, make sure that 'Uncompressed Export

Format' = 'WAV (Microsoft 8 bit PCM)'
4. Click OK to close window.
5. Press the Record button to start recording the call.
6. Press the Stop button to stop recording the call.
7. After completely recording the failing fax call, please save the wav recording by
using the 'Export as WAV' option available under the File menu.
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3 Other Fax Settings and Menus 3.1 Dump

Fax Settings Data

Shows all fax settings and their values.

3.2 Dump Fax T30 Log
Shows the T30 log of the last fax call.

3.3 Dump Last 10 Fax T03 Logs
Shows the T30 logs of the last ten fax calls.

3.4 Dump Caller ID Log
Provides caller ID (when available) information for the last 40 incoming calls.
3.5 Change Fax Settings
There are two options under the Change Fax Settings menu.

3.5.1 Change Faxtrace Settings

These settings control the level of fax debug that will be dumped during a fax job. These
settings should not be changed unless directed by the Fax PE.

3.5.2 Change Modulation Settings
These settings should not be changed unless directed by the Fax PE. However, the user
can control the max fax speed via the regular fax menu webpage (http://ipaddress >
Configuration > Fax Settings > Analog Fax Setup > Fax Send Settings or Fax
Receive Settings > Max Speed), or via the op panel.

Note: Separate Max Speed setting for Send and Receive. To set Max Speed to 14400 on
both send and receive, both settings must be changed under “Fax Send Settings” and
“Fax Receive Settings”.

http://ipaddress
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4 Fax Op Panel SE Menu settings

To access the fax se menu, press **411 from the home screen.

Warning! DO NOT change settings unless specified in Sections 5-7.

5 Troubleshooting a Fax Send failure

Step 1: Verify physical phone line connection
Connect an extension handset to the extension jack available at the back of the MFD
and pick up extension handset to check if a dial tone is present on the line.

If dial tone is present:
Proceed to Step 2.

If dial tone is not available:
Use another phone cable.
Use another phone line.
Check with telephone line provider.

Step 2: Verify phone line quality
Using the extension handset, check if phone line is free of any static or external noise in
order to ensure that line quality is suitable for fax transmissions.

If line quality is clear:
Proceed to Step 3.

If line is noisy:
Use another phone cable.
Use another phone line.
Check with telephone line provider.

Step 3: Verify if outgoing calls can be made using the phone line
Using the extension handset, place an outgoing voice call to check if call can be
completed.

If calls can be placed successfully:
Proceed to Step 4.

If unable to place any outgoing calls:
The phone line is problematic. Check with telephone line provider.

Step 4: Verify if phone line is analog or digital
Check if the MFD is connected to an analog or digital line.
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Digital line is used:
Proceed to Step 5.

Analog line is used:
Proceed to Step 6.

Step 5: Verify if MFD is connected to a VoIP line (internet provided phone service)
If MFD is connected to a VoIP line, verify if the server is configured to support fax
transmissions.

If server configurations support fax calls:
Proceed to Step 6.

Problem related to server setup:
Stop here. Check with VoIP provider.

Step 6: Verify phone system used
If MFD is connected to a PABX phone system proceed to Step 7, else proceed to Step 9.

Step 7: Verify ‘Behind a PABX’ user setting
If MFD is connected to a PABX phone system, enable ‘Behind a PABX’ user setting
and then test.

If MFD still fails to send faxes :
Disable ‘Behind a PABX” and proceed to Step 8.

If MFD is now able to send faxes :
Stop here. No additional troubleshooting steps are required.

Step 8: Verify ‘Dial Prefix’ user setting
If ‘Dial Prefix’ user setting contains a prefix number required to access an external line,
then make sure it is not included again when entering the destination number. If the
setting is empty then the prefix number must be entered before the destination number.

Problem not related to Dial Prefix:
Proceed to Step 9.

Problem related to Dial Prefix:
Stop here. No additional troubleshooting steps are required.

Step 9: Verify the nature of failure
Test to verify if the MFD is failing to send faxes to any destination number or only to a
specific destination number.

MFD fails to send only to a specific destination number:
Proceed to Step 10.
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MFD fails to send to any destination number:
Proceed to Step 11.

Step 10: Verify communications with the specific remote fax device
Test if faxes can be sent to the specific destination number from any other fax device.

Other fax device is able to send:
Proceed to Step 11.

Other fax device fails too:
Stop here. Problem is not with the MFD.
Check if remote fax device is configured to receive faxes.
Check if user’s phone number has been blocked by the remote end.
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Step 11: Adjust ‘Transmit Level’ SE setting
Test by adjusting the transmitted signal strength by decreasing/increasing the ‘Transmit
Level’ setting in steps of 1db. For example, if default value is -11 db, changing it to -
12db will decrease the signal strength by 1db and changing it to -10db will increase the
signal strength by 1db. Recommended adjustment range is ±5 db (in 1db steps) from the
default value.

MFD still fails to send faxes :
Restore the default Transmit level value and then proceed to Step 12.

MFD is now able to send faxes :
Stop here.
Continue using the newly changed Transmit level setting.

Step 12: Check the Fax error code
Print the T30 transmission/Job/Call log and check the error code being reported.
Verify it against the error codes listed in Section 7 and follow the suggested
resolution.

If Problem still persists:
Follow procedure described in Section 1 to escalate issue.

If Problem is resolved:
Stop here.
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6 Troubleshooting a Fax Receive failure

Step 1: Verify physical phone line connection
Connect an extension handset to the extension jack available at the back of the MFD
and pick up extension handset to check if a dial tone is present on the line

 If dial tone is present:
Proceed to Step 2.

 If dial tone is not available:
Use another phone cable.
Use another phone line.
Check with telephone line provider.

Step 2: Verify phone line quality
Using the extension handset, check if phone line is free of any static or order to ensure
that line quality is suitable for fax transmissions.

 If line quality is clear:
Proceed to Step 3.

 If line is noisy:
Use another phone cable.

Use another phone line.
Check with telephone line provider.

Step 3: Verify if incoming calls can be received on the phone line
Disconnect phone cable from MFD and connect it directly to the extension handset.
Have someone call this number and verify if extension handset rings. Allow 3-5 rings
then pickup handset and check if connection can be established with the caller.

 Extension handset rings and able to connect:
Reconnect the phone cable to the MFD and proceed to.

 Extension handset does not ring:
The phone line is problematic. Check with telephone line provider.

Step 4: Verify ‘Enable Fax Receive’ user setting Check
the value of the ‘Enable Fax Receive’ user setting.



Your Fax Escalation Checklist

19

 ‘Enable Fax Receive’ is On:
Proceed to Step 5.

 ‘Enable Fax Receive’ is Of:
Turn on the setting to enable MFD to receive faxes and then test. If
issue still exists proceed to Step 5.

Step 5: Verify ‘Distinctive Ring’ user setting

If distinctive ring feature is available on the phone line then verify if the appropriate
‘Distinctive Ring’ (Single, Double, Triple) setting is enabled on the MFD.

 Distinctive ring (Single, Double Triple) is enabled:
Proceed to Step 6.

 Distinctive ring (Single, Double Triple) is disabled:
Turn on the setting to enable MFD to answer to distinctive rings and then
test. If issue still exists proceed to Step 6.

Step 6: Verify if phone line is analog or digital
Check if the MFD is connected to an analog or digital line.

 Digital line is used:
Proceed to Step 7.

 Analog line is used:
Proceed to Step 8.

Step 7: Verify if MFD is connected to a VoIP line
If MFD is connected to a VoIP line, verify if the server is configured to support fax
calls.

If server configurations support fax calls:
Proceed to Step 8.

Problem related to server setup:
Stop here. Check with VoIP provider.

Step 8: Verify the nature of failure
Test to verify if the MFD is unable to receive faxes from any remote fax device or only
from a specific remote fax device.
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MFD fails to receive from any remote fax device:
Proceed to Step 12.

MFD fails to receive only from a specific remote fax device:
Proceed to Step 9.

Step 9: Verify communications with the specific remote fax device
Test if any other fax device connected to the phone line is able to receive faxes sent
from the specific remote fax device.

Other fax device is able to receive:
Proceed to Step 10.

Other fax device fails too:
Stop here. Problem is not with the MFD.
Contact telephone line provider to check if line is faulty.
Problem could be with the remote fax device.

Step 10: Verify ‘Block No Name Fax’ user setting
Verify if ‘Block No Name Fax’ setting is enabled to prevent the MFD from receiving
faxes from a remote fax device that has a ‘blank’ station ID setting.



Your Fax Escalation Checklist

21

 ‘Block No Name Fax’ is On:
Disable setting to start receiving faxes from devices with blank station ID.

 ‘Block No Name Fax’ is Of:
Proceed to Step 11.

Step 11: Check ‘Banned Fax List’ user setting
Check if ‘Banned Fax List’ contains the remote fax device’s number.

 ‘Banned Fax List’ contains sender’s number:
Remove number from list to allow MFD to receive faxes from it.

 ‘Banned Fax List’ does not contain sender’s number:
Proceed to Step 12.

Step 12: Adjust ‘Receive Threshold’ SE setting
Test by adjusting the received signal level by decreasing/increasing the ‘Receive
Threshold’ setting in steps of 2db. For example, if default value is -43 db, changing it to
-45db will decrease the received signal level by 2db and changing it to -41db will
increase the received signal level by 2db. Recommended adjustment range is between -
33db and -48db (in 2db steps).

MFD still fails to receive faxes:
Restore the default Receive Threshold value and then proceed to Step 13.

MFD is now able to receive faxes:
Stop here.
Continue using the newly changed Receive Threshold setting.

Step 13: Check the Fax error code
Print the T30 transmission/Job/Call log and check the error code being reported.
Verify it against the error codes listed in Section 7 and follow the suggested
resolution.

If Problem still persists:
Follow procedure described in Section 1 to escalate issue.

If Problem is resolved:
Stop here.
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7 Fax Error Codes

Error Code Description Resolution
000 No error occurred during fax

transmission

• Not applicable

200 Error occurred when
transmitting
training.

• Check line quality.
• Select a lower ‘Max Speed’
value under Fax Send settings.
• Adjust Transmit level.

3XX Error occurred when receiving
image data.

• Check line quality.
• Adjust ‘Receive Threshold’.
• Select a lower ‘Max Speed’
value under Fax Receive
settings.

4XX Error occurred when sending
image data.

• Check line quality.
• Adjust ‘Transmit Level’.
• Select a lower ‘Max Speed’

value under Fax Send settings.

5XX

Received unknown response
from remote fax device.

• Not applicable

6XX

Error occurred when receiving
a frame.

• Check line quality.
• Adjust ‘Receive Threshold’.



Your Fax Escalation Checklist

23

7XX Error occurred when sending a
frame. • Check line quality.

• Adjust ‘Transmit Level’.
• Select a lower ‘Max Speed’

value under Fax Send settings.

800 Received EOT unexpectedly
from
the modem in V34 mode.

• If error persists disable V34
modulation scheme.

802
Too many timeouts occurred
during ECM reception.

• If error persists disable ECM
mode.

803 Fax was canceled by user. • Not applicable
804 Unexpectedly received

disconnect
command from remote end.

• Check line quality.
• Adjust Transmit Level/Receive

Threshold values.
• Remote device could be

requesting an unsupported
feature.

805 Remote fax device failed to
respond to the DCS command.

• Adjust Transmit Level/Receive
Threshold values.

• Remote device could be
malfunctioning.

808
T1 Timeout occurred when
trying
to establish a connection with

• Adjust Transmit Level/Receive
Threshold values.
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remote fax device.
809

T2 Timeout occurred due to
loss
of command/response
synchronization.

•Adjust Transmit Level/Receive
Threshold values.

80A T5 Timeout occurred when
transmitting image data to
remote
fax device.

• Check line quality.
• Adjust ‘Transmit Level’.
• Select a lower ‘Max Speed’
value under Fax Send settings.

80B Too many errors when
transmitting image in ECM
mode.

• Check line quality.
• Adjust ‘Transmit Level’.
• Select a lower ‘Max Speed’

value under Fax Send settings.

80C Remote device failed to
respond to
the ‘CTC’ command.

• Select a lower ‘Max Speed’
value under Fax Send settings.

• Adjust ‘Transmit Level’.

80D Received too many requests
from remote end to repeat the
previous command sent.

• Check line quality.
• Adjust ‘Transmit Level’.
• Check if line conditions on

remote end will facilitate a good
connection.

80E Functional limitation- Remote
fax device does not support G3
receive
capability.

• Not applicable

811 Failed to detect a fax device at
the remote end. • Verify MFD is answering to fax

call and not a voice call.
• Decrease value of ‘Rings To

Answer’ setting.
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812
No more data rates available in
V34 modulation scheme.

• Adjust to a lower modulation
scheme.

813 Timeout occurred after waiting
too long to receive a good
frame.

• Adjust ‘Receive Threshold’.

814 Tried too many times at
selected
speed using V34 modulation
scheme.

• Adjust ‘Transmit Level’.
• Adjust to a lower modulation

scheme.

815 Fax transmission was
interrupted
due to power failure.

• Check MFD hardware if error
persists

818
Fax transmission failed due to
insufficient memory to store
scanned image.

• Adjust ‘Memory Use’ setting to
allocate more memory for send

jobs.

819
Fax transmission failed due
To insufficient memory to
store
received image.

• Adjust ‘Memory Use’ setting to
allocate more memory for
receive jobs.

81A
A timeout occurred during
transmission of a page in ECM
mode.

• Select a lower ‘Max Speed’
value under Fax Send settings.

880 Failure to transmit training • Select a lower ‘Max Speed’
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successfully in V17, V29,
V27ter
modulation schemes.

value under Fax Send settings.
• Adjust ‘Transmit Level’.
• Check line quality.

881 Failure to transmit training
successfully in V33, V29,
V27ter
modulation schemes.

• Select a lower ‘Max Speed’
value under Fax Send settings.

• Adjust ‘Transmit Level’.
• Check line quality.

882 Failure to transmit training
successfully in V17, V29
modulation schemes.

• Select a lower ‘Max Speed’
value under Fax Send settings.

• Adjust ‘Transmit Level’.
• Check line quality.

883 Failure to transmit training
successfully in V17, V27ter
modulation schemes.

• Select a lower ‘Max Speed’
value under Fax Send settings.

• Adjust ‘Transmit Level’.
• Check line quality.

884 Failure to transmit training
successfully in V29, V27ter
modulation schemes. • Select a lower ‘Max Speed’

value under Fax Send settings.
• Adjust ‘Transmit Level’.
• Check line quality.

885 Failure to transmit training
successfully in V17
modulation
scheme.

• Select a lower ‘Max Speed’
value under Fax Send settings.

• Adjust ‘Transmit Level’.
• Check line quality.
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886 Failure to transmit training
successfully in V29
modulation
scheme.

• Select a lower ‘Max Speed’
value under Fax Send settings.

• Adjust ‘Transmit Level’.
• Check line quality.

887 Failure to transmit training
successfully in V27
modulation
scheme.

• Select a lower ‘Max Speed’
value under Fax Send settings.

• Adjust ‘Transmit Level’.
• Check line quality.

888 Failure to transmit training
successfully at 2400 bps in
V27
modulation scheme.

• Adjust ‘Transmit Level’.
• Check line quality.

889

Failed to connect at minimum
speed supported by MFD.

• Adjust ‘Transmit Level’.
• Incompatible connection.

88A Failed to connect using V34
modulation scheme.

• Check line quality.
• Adjust to a lower modulation

scheme.
• Adjust Transmit Level/Receive

Threshold values.
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901 No fax tones detected from
remote end.  Verify if destination number is correct.

• Verify if remote fax device is enabled to
receive incoming faxes.
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902 No dial tone detected.

• Check by enabling ‘Behind a
PABX’ setting.
• Check phone line.
• Check MFD modem hardware.

903 Busy tone detected.
• Check with remote end if
successive redial attempts also
fail.

904 Hardware error detected.

•Check/replace MFD hardware if
error persists.

905 A timeout occurred after
dialing
number and waiting for
response.

• Check with remote end if
successive redial attempts also
fail.

906 Fax send was cancelled by
user. • Not applicable

907
Modem detected a digital line
connection.

• Verify MFD is connected to an
analog phone line.

908 Phone line was disconnected. • Restore phone line connection.

A00
Received request for
unsupported
function from remote fax
device.

• Not applicable.
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A01 Received request for
unsupported
image width from remote fax
device.

• Not applicable.

A02 Received request for
unsupported
image resolution from remote
fax
device.

• Not applicable.

A03 Received request for
unsupported
compression type from remote
fax

• Not applicable.

A04 Received request for
unsupported
image length from remote fax
device.

• Not applicable.

F00 Unknown error occurred • Not applicable


